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Introduction

Welcome to the Meridian 800 Reference DVD/CD Player!

This User Guide provides full information about using the DVD/CD

player in conjunction with your other equipment, to achieve the

superb results you can expect from it.
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INTRODUCTION

The 800 Reference DVD/CD Player

The design philosophy of the Meridian 800 Reference DVD/CD Player is
simply to deliver the highest possible quality audio and video signals from
every format of DVD and CD, without compromises at any stage. It
combines Meridian’s extensive experience in producing audiophile compact
disc players with their experience in applying state-of-the-art digital
processing techniques to audio and video equipment, resulting in a DVD/
CD player that delivers reference quality signals whatever the media.

The 800 Reference DVD/CD Player uses a precision DVD-ROM drive with the
audio and video data read asynchronously and then triple buffered to
isolate output timing from the mechanics of the drive. The audio data is
also de-jittered using precise master oscillators to give a clear, open,
authoritative sound.

Meridian multi-channel link

The 800 Reference DVD/CD Player incorporates a unique multi-channel link,
which allows it to provide an upsampled 6-channel PCM stream to a
compatible digital surround controller, such as the Meridian 861 Reference
Digital Surround Controller, for the highest possible quality sound.

An additional feature of the Meridian multi-channel link is that it provides
intelligent stream content information from the 800 DVD/CD Player,
allowing the digital surround controller to select an appropriate preset
depending on whether the source is music or a movie soundtrack, and
whether it is 2-channel or multi-channel.

DVD-Audio

DVD-Audio discs now make music recordings available with significantly
higher quality than Audio CDs, with up to 24-bit resolution and up to
192kHz sampling rate. The 800 Reference DVD/CD Player is capable of
taking advantage of the highest-quality audio available on DVD-Audio
discs, and by using the proprietary MHR (Meridian High Resolution)
encoding scheme, in conjunction with Meridian DSP Loudspeakers, allows
the signal to be preserved at full resolution and sampling rate until the
latest possible stage in the reproduction chain.

DVD-Audio discs are also capable of offering multi-channel audio. The 800
DVD/CD Player can be fitted with a multi-channel digital output card to
allow up to six discrete channels to be connected to Meridian DSP
Loudspeakers, or a digital surround controller with discrete multi-channel
inputs, such as the 861.
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The 800 DVD/CD Player also provides access to the range of additional
features available on the DVD-Audio format, including still images and
video sequences.

DVD-Video

The multi-channel soundtracks on DVD-Video discs are encoded and
compressed, using the Dolby Digital, MPEG, or DTS encoding systems. The
800 Reference DVD/CD Player uses mathematically precise digital signal
processing (DSP) to decode the soundtrack into discrete channels. The video
is processed using broadcast-quality video circuitry, with the ability to
reproduce both PAL and NTSC video formats and to convert between them
if the television or video display is not capable of displaying both formats.

Audio CDs

Because the CD catalogue is so comprehensive, CD will be the major source
of music enjoyment for many years. In designing the 800 Reference DVD/CD
Player no compromises have been permitted in reproducing conventional
audio CDs. The 800 uses triple buffering and a FIFO to remove the timing
variations that typically occur with reading data from an audio CD,
resulting in an extremely clear and authoritative sound.

MP3 audio CDs

The 800 Reference DVD/CD Player can also play CD-ROMs containing
directories of MP3 audio files. This provides a convenient way of archiving
record collections to achieve up to 10 times the capacity of a conventional
CD where sound quality is not of primary importance.

MP3 discs can be created from a computer using appropriate MP3 encoding
software and a CD-ROM writer. Generate the MP3 files with a data rate of
at least 128Kbits per second. Group the tracks into folders to create
separate albums on the disc. Do not create folders within folders.

Tracks and albums are played in the order in which they are recorded onto
the CD-ROM. Usually this will be in alphabetical order of filename.
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Overview

The architecture of the 800 allows for wide flexibility – future sources and
formats can be handled by upgrading software, cards, or drives.

Inputs

The 800 Reference DVD/CD Player incorporates a DVD-ROM drive and
special electronics for media playback. Data from the drive, or from the
other inputs, is buffered and de-jittered to ensure perfect output timing
irrespective of the performance of the drive or other sources.

The 800 can also be used as a system controller, and may optionally be
fitted with digital and analogue inputs. Although the 800 does not include
a variable output, it can control the overall system volume with Meridian
DSP speakers.

Processing

The 800 Reference DVD/CD Player incorporates extensive DSP for resolution
enhancement and other signal processing on the data stream.

Outputs

The 800 Reference DVD/CD Player provides multi-channel digital outputs
for direct connections to multi-channel digital inputs of a digital surround
processor such as the 861 Reference Digital Surround Controller. This
allows multi-channel surround to be reproduced without loss of quality.
The auxiliary output can be used either as a supplement to the surround
decoder, or to feed a second zone. Alternatively the 800 can be used as a
stand-alone DVD/CD player and controller using the discrete multi-channel
digital outputs to connect directly to up to six Meridian DSP loudspeakers.

The digital outputs can operate at up to 96kHz and may also be used to
allow integration of a secure closed Meridian system using MHR. These
outputs can provide decoded PCM or bitstreams such as AC-3, MPEG, or
DTS.

The 800 can also be fitted with analogue outputs with 192kHz, 24-bit
conversion capability. The 800 does not provide tape outputs and does not
generally support copying.
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Video

The 800 provides composite video, S-video, and component video (Y, Pr, Pb)
outputs, in PAL or NTSC format, suitable for driving virtually any television,
monitor, or projection system. The video outputs and conversion system are
very high quality and feature very low noise and jitter.

In addition to providing high-quality video outputs, the 800 has the ability to
give help and system control feedback information in an on-screen display.
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Typical specification

Drives

• Internal ATAPI/IDE drive, with space for a second drive.

Audio in and out

The 800 is supplied as standard with digital or analogue outputs, or both:

• 6-channel (multi-channel) digital outputs, normal or encrypted, PCM or
compressed.

• 2-channel (auxiliary) digital output, normal or encrypted, PCM or
compressed.

• Either 2 or 6 analogue outputs, balanced or unbalanced.

In addition the 800 can be fitted with a variety of 800 Series cards to
provide additional connections, including:

• Up to 11 2-channel digital inputs. Re-nameable legends. 32 to 96kHz
sampling and up to 24-bit precision.

• Up to 11 2-channel analogue inputs. Adjustable sensitivity. Re-nameable
legends.

• 6-channel (multi-channel) analogue input.

Signal processing

800 uses Meridian’s proprietary DSP software to provide the following
powerful Modes:

• Upsampling/downsampling.
• FIFO and error correction.
• Resolution enhancement.
• MLP decoding.

Video

• Composite, S-video, or component video.
• NTSC or PAL.
• 16:9 or 4:3 letterbox/pan-scan.
• Black level option for NTSC.

Controls, etc.

Front-panel facia controls for:
• Open, Play, Stop, Pause, Previous, Next, and Off.
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Hinged control panel provides additional switches for:

• Open, Function, Source, Copy, Store, and Setup.
• Top Menu, Parameter menus, Return, and Enter.
• Display, Mute, Gain+, and Gain-.

Display

• 20-character dot-matrix display with adjustable brightness and
contrast.

• Lights for MLP, Multi, Repeat, and DVD/CD.
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Using the 800 Reference DVD/CD Player

This chapter provides a summary of the functions of the 800 Reference

DVD/CD Player to identify the controls which you use to operate the

unit.

It also provides step-by-step instructions for operating the DVD/CD

player, using either the front panel or the Meridian System Remote.
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USING THE 800
REFERENCE DVD/CD

PLAYER Front panel keys

MLP

Repeat

Multi

DVD

CD

OffMeridian 800

Gain +

Gain -

CopyOpen

Mute

Store

Setup Display

Source

Function

Menu

EnterReturn

Setup
Displays the 
Setup menu

Function
Selects a special
function 

Drive
DVD/CD drive

Play
Plays the disc

Stop
Stops the disc

Pause
Pauses the disc

Next/Previous
Selects the next
or previous
chapter/track

Off
Switches to
standby

Return
Returns from
a menu 

Enter
Confirms a
menu
selection 

Open
Opens/closes
the disc drawer

Display
Changes the
information
displayed

Mute
Mutes or 
restores
the sound

MLP
MLP indicator

Top Menu
Displays the Top 
Menu

Store
Stores the
parameters
for a preset

Source
Selects the 
source

Multi
Multi-channel 
audio indicator

DVD/CD
Shows the type 
of disc playing

Gain+/Gain-
Change the
system volume

Copy
Controls copy 
source

Menu keys
Allow you to
select and change
parameters

Repeat
Repeat indicator
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REFERENCE DVD/CD

PLAYER Meridian System

Remote keys

Subtitle

Off

EnterReturn

Function 0 Top Menu

#

Record

Slow/Page ]

OSD

[ Page

Angle Audio A-B Phase

Setup

Band

7 8 9

4 5 6

1 2 3

Menu Volume

Display MuteDSP

Clear

Store

Repeat

CD RADIO LP TV TAPE 1 TAPE 2 CDR CABLE DVD VCR 1 VCR 2 LD

Pause
Pauses the disc

Store
Stores a preset

Repeat
Repeats a 
chapter/track
A-B
Repeats a section

Function
Selects a special
function 

Menu keys
Select or 
change 
parameters

Return
Returns from a 
menu

Top Menu
Displays the 
Top Menu
#
Title/timecode 
entry

Enter
Confirms a 
menu selection

DSP
Changes the 
DSP preset
Band
Changes the 
tuner band

Menu
Displays the 
disc menu
Setup
Displays the 
Setup menu

Clear
Clears an entry

Display
Changes the 
front-panel 
display

Fast reverse
Scans 
backwards
[ Page
Browse previous 
DVD-A page

Stop
Stops the disc

Fast forward
Scans forward
Slow
Plays in slow 
motion
Page ]
Browse next 
DVD-A page

Next
Selects the next 
chapter/track
OSD
On-screen 
display

Play
Plays the disc
Audio
Changes the 
audio track

Number keys
Select a title, 
chapter, or track 
by number

Volume keys
Change the
volume

Mute
Mutes or 
restores the 
sound

Off
Switches to
standby

Previous
Selects the 
previous track
Angle
Changes the 
camera angle

Source keys
Select a source

Subtitle
Turns subtitles 
on/off
+Function
Subtitle 
language
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USING THE 800
REFERENCE DVD/CD

PLAYER Switching on and off

When not playing, the DVD/CD player should be left in the standby state.
This uses a minimal amount of electricity, but ensures that the components
of the DVD/CD player operate at maximum efficiency from the moment
you start.

After switching on the 800 runs an initialising cycle which takes a few
seconds. Do not press any keys until the standby display appears.

If you are not going to use the DVD/CD player for several days you should
switch the unit off completely at the rear panel, and disconnect it from the
AC power supply.

To switch on from standby

• Press Open, *, or > (front panel), or select a source on the remote.

If the DVD/CD player is part of a Meridian system it will automatically
switch on any other unit in the system, such as the 861 Reference Digital
Surround Controller and Meridian DSP Loudspeakers.

To switch to standby

• Press Off (front panel or remote).

If you have other Meridian equipment or Meridian DSP Loudspeakers
connected to the DVD/CD player these units will also switch to standby.

If a disc is currently playing, switching to standby will stop the disc, and the
disc can safely be left in the unit.

Always remove any disc before moving or shipping the 800.
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REFERENCE DVD/CD

PLAYER

These functions are normally

disabled while the disc’s copyright

notice is being displayed.

Playing a disc

Most DVDs start playing automatically when you close the tray. Some DVDs
are double-sided, and need to be turned over during play.

DVD-Audio discs usually behave differently depending on whether you
start them by closing the tray, or pressing >. Depending on how the disc is
authored the typical behaviour is:

• Inserting the disc and pressing > will start playing immediately from
group 1, track 1.

• Inserting the disc and closing the tray will display the Top Menu.

To insert a disc

• Press å (front panel) or Function * (remote) to open the tray.

• Place the disc, label side up, in the tray.

Ensure that the disc is correctly seated in the tray before closing the tray.

• Press å again or > (front panel or remote), or gently push the front of
the tray, to close the tray.

To play the disc

• Press > (front panel or remote).

The on-screen display shows  and the front-panel display shows the
title, chapter, and elapsed time (DVDs), or track number and elapsed time
(CDs).

For example, on chapter 14 of title 1:   1 14 0:49:38

To move to the next or previous chapter or
track

• Press ] or [ (front panel or remote).

The on-screen display shows  or .

To move to the next or previous album (MP3 discs only)

• Press V or A (remote).

The on-screen display shows  or .
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USING THE 800
REFERENCE DVD/CD

PLAYER Playing DVD-Audio discs

The Meridian 800 DVD/CD Player allows you to take full advantage of all
the benefits provided by DVD-Audio discs, including one or more of the
following features:

• Higher-quality audio up to 24 bit, 192kHz.
• Longer playing times.
• Multi-channel surround sound.
• Additional materials, such as photographs, lyrics, and track listings.
• Videos.

Each DVD-Audio disc may offer a different selection of these features,
depending on the material on the disc.

A DVD-Audio disc is identified by the following icon on the on-screen
display:

Groups

DVD-Audio content can be divided into up to nine groups, similar to titles
on Video discs. Each group can contain up to 99 tracks. Groups can be used
to separate content, like high-quality audio from movie sections.
Alternatively groups might provide the same content in different forms,
such as multi-channel and stereo.

Some DVD-Audio discs may contain hidden groups that require a
password for access. Follow the instructions given on the disc.

Still images

DVD-Audio tracks often include still images, called pages, which are
displayed while the disc is playing. These images may include text or menu
buttons. According to the disc these images may be browsable, selected
from menus, or change automatically.

DVD-Video compatibility

To allow them to be played on DVD-Video players with no DVD-Audio
capability, some DVD-Audio discs provide one or more groups with the
content recorded in DVD-Video format; typically AC-3 or DTS. Selecting one
of these with the Meridian 800 DVD/CD Player will generally give poorer
quality audio than selecting the DVD-Audio group.

In some cases a DVD-Video group will be used to provide a music video or
video sequence. Some discs provide DVD-Audio on one side and DVD-Video
on the other.
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USING THE 800
REFERENCE DVD/CD

PLAYER To locate a group by number

• Press # (Function Top Menu on the remote).

The on-screen display prompts you to enter the group number:

• Enter the group number using the number keys (remote).

• Press > or Enter (remote) to play from the group number you have
specified.

To display DVD-Audio images

• Press Page ] (Function ˘ on the remote) or [ Page (Function ¯
on the remote) to step between the browsable images.

Note: These functions will only work if the disc has been authored to allow
browsing.

To display the Top Menu

• Press Top Menu on the remote.

The player will go to the disc menu, if it exists.

To resume play:

• Press Top Menu again.
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USING THE 800
REFERENCE DVD/CD

PLAYER Locating a specific title, chapter, or
track

Normally, DVD-Video discs are divided into one or more titles, and the titles
are subdivided into Chapters. Audio CDs are divided into tracks.

The DVD/CD player allows you to play an entire disc, or start playing from
any chapter or track number.

You can also enter a specific chapter/track or title number to locate the
corresponding section of the disc directly.

To play starting from a particular chapter or track

• Press ] or [ (front panel or remote) to step through the track numbers
until the display shows the track you want to play:

For example, to play chapter 23:    1 23 1:17:33

The on-screen display shows the chapter or track number as you step:

After a short delay the chapter or track you have selected will start to play.

To locate a chapter or track by number

• Press # (Function Top Menu on the remote) twice.

The on-screen display prompts for you to enter the chapter or track
number:

• Enter the number of the chapter (DVD) or track (audio CD) using the
number keys (remote).

The number is displayed as you enter it:

• Press > or Enter (remote).

The DVD/CD player starts playing from the chapter or track number you
specified.
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USING THE 800
REFERENCE DVD/CD

PLAYER To locate a title by number

• Press # (Function Top Menu on the remote).

The on-screen display prompts you to enter the title number:

• Enter the title number using the number keys (remote).

• Press > or Enter (remote) to play from the title number you have
specified.

To play from a specified timecode

• Press # (Function Top Menu on the remote) three times until the
on-screen display prompts for a timecode:

• Enter the timecode using the number keys (remote).

• Press > or Enter (remote) to play from the timecode you have specified.
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USING THE 800
REFERENCE DVD/CD

PLAYER Stopping, pausing, and resuming
play

You can stop or pause a disc, and then resume play at the same position.

To stop play

• Press * (front panel or remote).

The on-screen display shows .

This Stop/Pause icon indicates that you can resume from the current
position.

To resume after stopping

• Press >>>>> (front panel or remote).

The disc will resume playing from the position where you stopped

playback, and the on-screen display shows .

To pause play

• Press = (front panel or remote).

The on-screen display shows .

To step forward frame by frame

If you are playing a DVD-Video disc you can step forward, frame by frame,
while it is paused:

• Press = (front panel or remote).

The on-screen display shows .

To continue after pausing

• Press > (front panel or remote).

To return to the start of the disc

• Press * (front panel or remote) while the disc is stopped.

The on-screen display shows  and the disc is reset to the start.
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USING THE 800
REFERENCE DVD/CD

PLAYER Changing the front-panel display

The 800 Reference DVD/CD Player displays information about the current
disc and settings on the 20-character front-panel display.

You can adjust the contrast and brightness of the front-panel display for
optimum viewing, and choose what information is displayed.

To change the contrast or brightness

• Press Function > or < (remote or under the front panel), until the
display shows the current contrast or brightness.

For example: DVD  Contrast  10

• Press Function A or V (remote or under the front panel), to change the
selected setting.

You can change the contrast or brightness between 0 and 15.

To change the displayed information

• Press Display (remote or under the front panel).

Each time you press Display the display will step between the options
shown in the following table:

Display option Example

Source and volume
 DVD               65

Title, chapter, and elapsed time (DVD),
or track and elapsed time (CD)     1 32 1:55:58

Sampling rate, precision, and audio format*
 44k1 16Bit AC-3 *DVD

Blank

* indicates an unprotected disc.

If the Diagnostic displays option has been selected, additional diagnostic
displays are included; see Changing the setup options, page 70.
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REFERENCE DVD/CD

PLAYER Displaying disc information on
screen

You can display information about the current DVD or CD on the on-screen
display.

To display disc information on screen

• Press OSD (Function ] on the remote) or Function Display (under the
front panel).

• To display the second DVD on-screen display, press twice .

The following table shows the information displayed for each disc format:

Disc Information

DVD-Video 1

Title
number

Chapter
number

Elapsed
title time

Camera
angle

Play
mode

DVD-Video 2

Subtitle
language

Audio
track

Audio
format

Repeat
mode

Play
mode

Audio CD

Track
number

Elapsed
disc time

Repeat
mode

Play
mode

DVD-Audio 1

Group
number

Track
number

Elapsed
group time

Play
mode

DVD-Audio 2

Group
number

Track
number

Audio
format

Play
mode

Repeat
mode

MP3 audio CD*

Album
number

Track
number

Elapsed
track time

Repeat
mode

Play
mode

*The album number is not displayed if there is only one album.

To turn off the on-screen display

• Press OSD (Function ] on the remote) or Function Display (under the
front panel) again.
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Advanced features

This chapter describes the more advanced features of the DVD/CD

player. These features are not essential if you simply want to enjoy

DVD-Video discs or audio CDs, but they allow you to take full

advantage of the range of options available with the DVD format.

Note that many of the advanced features depend on the content of

the particular disc you are playing.
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ADVANCED FEATURES

Selecting options from a menu

DVDs generally provide a Top Menu, which provides access to the content
on the disc.

Many DVD-Video discs also provide a disc menu, which allows you to select
additional sections or special options.

You can operate the menus either using the remote or using the keys
under the front panel.

To select a title or group using the Top Menu

• Press Top Menu to display the Top Menu on the screen.

• Press A, V, <, or > to highlight a title or group, and press Enter to
select it.

The DVD/CD player starts playback from chapter 1 of the title (DVD-Video
disc) or track 1 of the group (DVD-Audio disc) you selected.

Alternatively, press Return or Top Menu again (remote or under the front
panel) to return to the original position on the disc.

To select an option from the disc menu

• Press Menu to display the disc menu on the screen.

A typical disc menu looks like this:

• Press A, V, <, or > to highlight an option, and press Enter to select it.

Alternatively, press Return to exit from the menu without selecting an
option.
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Fast and slow-motion play

You can play back DVD-Video discs faster than normal, at between twice
and eight times normal speed, or in slow motion, at between one-half and
one-sixteenth of normal speed.

You can also play back audio CDs faster than normal.

Note: The sound is muted when playing back DVD-Video discs faster or
slower than normal.

To play DVD-Video discs or audio CDs faster than
normal

• Press ˘ or ¯ (remote) during playback.

Each time you press the key the speed switches between
twice and eight times normal speed, as shown by the on-

screen display:

       

To play DVD-Video discs in slow motion

• Press Slow (Function ˘ on the remote) during playback.

The speed switches between one-half, one-quarter, one-eighth, and one-
sixteenth normal speed, as shown by the on-screen display:

       

To resume normal speed

• Press > (front panel or remote).

Only one speed is available

on DVD-Audio discs, and

fast forward/back is not

 available for MP3 discs.
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Playing repeatedly

You can play back a specified title, chapter, track, or section of a disc
repeatedly.

To repeat a title, chapter, or track

• Select the title, chapter, or track you want to repeat.

• Press Repeat (remote) to switch between Ch. (chapter
repeat), Title (title repeat), and Off (no repeat).

The current repeat mode is displayed on the on-screen display:

To repeat a specific section of a disc

• Press A-B (Function Repeat on the remote) at the beginning of the
section you want to play back repeatedly.

The on-screen display shows A–:

• Press A-B again at the end of the section.

The on-screen display shows A–B:

The DVD player automatically returns to the start of the section and plays it
back repeatedly.

To cancel the repeat press A-B a third time.

Repeat is not available for

DVD-Audio discs.
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Selecting an audio soundtrack

You can select one of the audio soundtracks from those included on a DVD-
Video disc during playback.

To display the current audio setting

• Press OSD (Function ] on the remote) or Function Display (under the
front panel) twice to display the second on-screen display bar:

This gives the following information:

Information Examples

Soundtrack language (when available) ENG, FRE, GER, SPA.

Soundtrack number, and total number 2/3
of soundtracks

Recording system LPCM, MLP, DD, MPEG, DTS.

To select the audio setting (DVD-Video)

• Press Audio (Function > on the remote).

Each time you press Audio the next available soundtrack is selected.

To switch between stereo and multi-channel
(DVD-Audio)

Some DVD-Audio discs allow you to switch between stereo and multi-
channel. If this feature is available:

• Press Audio (Function > on the remote).

The 800 will switch to the alternate format and restart the current track.
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Displaying subtitles

Many DVD-Video discs include subtitles in up to 32 different languages.
While you are playing a disc you can turn the subtitles on or off, and select
the subtitle language from those provided on the DVD-Video disc.

To display the current subtitle setting

• Press OSD (Function ] on the remote) or Function Display (under the
front panel) twice to display the second on-screen display bar:

This gives the following information:

Information Examples

Subtitle language when available ENG, FRE, GER, SPA, OFF.

Subtitle number, and total number 2/3
of languages

To select the subtitle language

• Press Function Subtitle (remote).

Each time you press Function Subtitle the next subtitle language is
selected.

To turn subtitles on or off

• Press Subtitle (remote).

The on-screen displays shows the current subtitle setting:
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Selecting the camera angle

Some DVD-Video discs include scenes recorded from up to nine different
camera angles, and you can select the camera angle while you are playing
the disc.

To display the camera angle

• Press OSD (Function ] on the remote) or Function Display (under the
front panel) to display the first on-screen display bar.

The camera angle icon shows the current camera angle and the total
number of angles:

To select or change the camera angle

• Press Angle (Function [ on the remote), while viewing a scene with
multiple camera angles.

Each time you press Angle the next camera angle is selected after a short
delay.
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Setting the parental lock

Some DVD-Video discs are provided with a parental lock function to allow
you to restrict playback of scenes whose content exceeds a specified rating
unless a password is entered.

You can operate the menus either using the remote or using the keys
under the front panel.

To set the parental lock

• With the disc stopped press Setup.

The Setup menu is displayed on the on-screen display:

• Press Enter to select Playback options.

The Playback options menu appears.

• Press V to highlight Rating and press Enter to select it:
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The following screen prompts you to enter the password:

• Enter your four-digit password using the number keys (remote), and
press Enter.

Initially the password is set to 7890, but you can change it to any password
you choose as described in To change the password, page 30.

The following screen then allows you to set the rating level:

• Press A or V to highlight the rating level you want to set, or highlight
Off to turn the parental lock off, and press Enter to select it.

Level 1 corresponds to general viewing, level 3 is equivalent to the USA movie
rating PG, and level 8 corresponds to adult viewing.

The rating level you have set will be displayed in the Playback options
menu.
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To change the password

• Highlight Change password on the Set rating level screen and press
Enter to select it.

The following screen allows you to specify the new password:

• Enter the four-digit password you want to use and press Enter to select
it. The password cannot start with a zero.

Take care not to forget your

password, or you will need to contact

your Meridian dealer to reset it for

you.
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Using the DVD/CD player preamplifier

features

In addition to playing DVD discs and audio CDs, the 800 Reference

DVD/CD Player can act as a controller for up to 11 other sources.

This chapter explains how to use these features from either the front

panel or the Meridian System Remote.
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FEATURES Selecting a source

If you are using the 800 Reference DVD/CD Player as a controller you can
connect up to 11 other sources to it, and select them from the front panel
or remote.

The DVD/CD player provides the following 12 sources:

CD, Radio, LP, TV, Tape 1, Tape 2, CDR, Cable, DVD, VCR1,
VCR2, LDisc.

The DVD and CD sources usually correspond to the
internal drive(s).

The input associated with each of the other sources depends
on how the DVD/CD player has been set up; for more information

refer to the Configuring the DVD/CD player using a computer, page 55.

To select a source

• Press Source (under the front panel) until the display shows the source
you want, or press the appropriate source key on the remote; eg CD.

The display shows the source and volume setting.

For example, if you select the Radio
source the display might show: Radio             65

Your installer may have

customised the labels displayed for

each source to suit your other

equipment.

The DVD/CD player mutes the

sound while you change source.
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FEATURES Adjusting the system volume

The 800 Reference DVD/CD Player can be used as the controller in a system
with Meridian DSP loudspeakers, in which case you can adjust the volume
using the front panel or remote. The volume changes in precise steps of
1dB, where 9dB is equivalent to doubling the loudness. The current volume
setting is displayed in dB on the front-panel display, and can be varied in
the range 1 to 99dB.

To change the volume

• Press Gain + or Gain - (under the front panel), or the red A or V keys
on the remote.

As you adjust the volume setting the display shows the current volume
level.

For example: DVD               65

To mute the sound

• Press Mute (under the front panel, or remote).

The display will show: Mute

To restore the sound

• Press Mute again.

Alternatively, the sound will be restored if you adjust the volume.



34

USING THE DVD/CD
PLAYER PREAMPLIFIER

FEATURES Changing the balance or phase

To change the balance

• Press Function < or > (remote or under the front panel) until the
display shows the current balance.

For example: CD    Balance   <0>

• Press Function A or V (remote or under the front panel) to move the
listening position.

The display shows the direction and position of the listening position.

For example: CD    Balance   <3

The arrow indicates the direction, and the number indicates the position
where 0 is central, 8 is in line with the corresponding main speaker, and 10
is fully to one side.

To change the absolute phase

• Press Function < or > (remote or under the front panel) until the
display shows the current phase.

For example:
CD    +  Phase

• Press Function A or V (remote or under the front panel) to change the
phase.
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DVD-Video discs are capable of providing a wide range of options and

special features.

This chapter explains how use the options on the Setup menu to

configure the operation of the 800 Reference DVD/CD Player.

You can operate the menus either using the remote or using the keys

under the front panel.
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Setting default options

The default options are divided into the following three menus of settings:

Menu Description

Playback options The audio, subtitle, and menu languages, parental rating, and screensaver.

Video setup The display settings.

Audio setup The audio settings.

Information The region code and engineering information.

You choose the menu of settings you want from the main Setup menu.

To display the Setup menu

• If necessary switch on the DVD player and press * if a disc is currently
playing.

• Press Setup.

The main Setup menu will be displayed:

To select an option from a menu

• Press A or V to highlight the option you want:

• Press Enter to select the option.
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To return to the previous menu

• Press Return.

To exit from the setup menus

• Press Setup.
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Selecting the playback options

The Playback options menu lets you change the default language for the
audio soundtrack, subtitles, and on-screen menus, the parental rating, and
the screensaver:

To select the default soundtrack language

Most DVD-Video discs include a selection of soundtrack languages. English
is usually the default soundtrack language, but you can use the Audio
language menu to set a different default language if you prefer.

• Highlight Audio in the Playback options menu, and press Enter.

The Audio language menu is displayed:

• Press <, >, A, or V to highlight the default soundtrack language you
want to use, or select Original to choose the original soundtrack
language, and press Enter.
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To set the default subtitle language

DVD-Video discs can include subtitles in up to 32 different languages.

The 800 DVD/CD Player allows you to select whether subtitles are displayed
by default, and specify the preferred language if it is available on the disc.

• Highlight Subtitles in the Playback options menu, and press Enter.

The Subtitle language menu is displayed:

• Press <, >, A, or V to highlight the language you want to use, and press
Enter.

Alternatively, select Auto to automatically display subtitles in the specified
audio language if no soundtrack is available for that language.

To select the disc menu language

The 800 DVD/CD Player allows you to choose the language for the disc
menus.

• Highlight Menu in the Playback options menu and press Enter.

The Menu language menu is displayed:

• Use A or V to highlight the language you want to use, and press Enter.
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Selecting the display settings

The Video setup menu lets you change the video and operational settings
of the 800 DVD/CD Player:

To specify your display format

You should set the Display aspect option to the format that your display
can accommodate.

Select 16:9 if you have a widescreen display, or an external processor for
picture formats.

If you have a standard 4:3 television you also have the choice of displaying
widescreen pictures cropped to fill your television screen (pan-scan), or
with black bars above and below the picture (letterbox).

• Highlight Display aspect in the Video setup menu, and press Enter.

The Display aspect ratio menu is displayed:

• Press V or A to select the format of your TV, and press Enter.

The pan-scan feature is not available

on some discs, in which case letterbox

format will be used.
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The option you select will not affect

the composite output, which is always

available.

To select the video output format

This option should be set according to which of the S-video or
COMPONENT video outputs you are using.

• Highlight Video output in the Video setup menu,
and press Enter.

The Video output menu is displayed:

• Press V or A to highlight the appropriate option, and press Enter.

Choose S video or Component to use the corresponding output.

To select the black level for NTSC

• Highlight Black level in the Video setup menu, and press Enter.

The Black level menu is displayed:

• Press V or A to highlight the appropriate option, and press Enter.

If you are using the Composite or S-video outputs of the DVD player you
should usually select the 7.5 IRE option.

If you are using the component outputs select the option that matches
your display.

This only affects NTSC playback.
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If you use the 800 to play both NTSC and PAL material the recommended
setting is 0 IRE.

To select closed caption subtitles

Some DVD-Videos include closed caption subtitles, which provide a
description of sound effects for the hard of hearing; for example “door
creaks”.

• Highlight Closed caption in the Video setup menu, and press Enter.

The Closed captions menu is displayed:

• Press V or A to highlight On or Off, and press Enter.

To select the TV standard

DVD movies are produced in both PAL and NTSC television formats. The
800 DVD/CD Player is capable of converting between formats, to allow you
to view DVD movies in either format even if your television is not capable
of displaying that format. However the conversion process introduces some
picture degradation, and may disable disc menu operation on some discs.

• Highlight TV standard in the Video setup menu, and press Enter.

The TV standard menu is displayed:

• Press V or A to highlight the option you want, and press Enter.
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Choose Auto if your television can display both PAL and NTSC video, or
choose NTSC or PAL to match the format supported by your television.

If your television is capable of displaying both formats the recommended
setting is Auto, which supplies the unconverted video signal.

A separate Powerup std option lets you specify the standard to be
selected when you bring the 800 out of standby:

• Press V or A to highlight the option you want, and press Enter.

To specify the screensaver options

• Highlight Screensaver in the Video Setup menu, and press Enter.

The Screensaver options menu is displayed:

These options allow you to ensure that a static image does not remain on
the display; this can damage certain types of display.

The Stop timeout automatically fades the screen to black if the 800
DVD/CD Player is left in stop mode and no key is pressed for the specified
time.

The Pause timeout automatically switches the 800 from pause into stop
mode if no key is pressed for the specified time.
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• Highlight Stop timeout or Pause timeout in the Screensaver
options menu, and press Enter.

The appropriate menu is displayed:

• Press V or A to select the timeout delay, and press Enter.

You can also adjust the intensity of the logo screen.

• Highlight Logo screen in the Screensaver options menu, and press
Enter.

The Logo screen intensity menu allows you to select between High, Low
or Off:
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Selecting the audio settings

The Audio setup menu lets you change the audio settings of the 800
DVD/CD Player:

To specify the digital format

• Highlight Digital format in the Audio setup menu, and press Enter.

The following menu is displayed:

• Press V or A to select the output you want to configure, and press
Enter, then press V or A to select Yes or No, and press Enter to
confirm the setting.

Main outputs specifies the setting for the main multi-channel outputs.
Aux output specifies the setting for the auxiliary output.

• Select No if you are connecting the specified output to an external
decoder and you want the external decoder to decode the bitstream; for
example Dolby Digital, DTS, etc.

• Select Yes if you want the 800 DVD/CD Player to convert the audio to 2-
channel PCM on the corresponding outputs for connection to an 861 via
a Meridian multi-channel link, or for direct connection to Meridian DSP
Loudspeakers or a digital preamplifier.
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To specify the maximum sampling rate

• Highlight Max rate in the Audio setup menu, and press Enter.

The following menu is displayed:

• Press V or A to choose between 48kHz and 96kHz, and press Enter.

Choose the appropriate rate for the decoder or preamplifier your 800 DVD/
CD Player is connected to.

When playing audio at higher rates it will be downsampled to the rate you
have specified.

To specify Meridian High Resolution (MHR)

• Highlight MHR in the Audio setup menu, and press Enter.

The following menu is displayed:

Meridian High Resolution is a proprietary format using encryption and anti-
copy methods that allows secure transfer of audio streams between
elements of a Meridian-only system for the purpose of playback only. It
provides a secure copyright protection environment and has the very
important benefit of lowering jitter and improving sound quality on all
material.
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• If you are connecting either of the outputs to a Meridian product that is
MHR compliant, such as the 861, select the option for the corresponding
output to take advantage of MHR.

• Select Neither if there are no MHR-compliant Meridian products in your
system.

To enable the multi-channel outputs

• Highlight Multi-channel in the Audio setup menu, and press Enter.

The following menu is displayed:

• Press V or A to select between No and Yes, and press Enter.

Only select Yes if your decoder can accept a multi-channel input.

To specify Dolby Digital compression

This option is useful for reducing the dynamic range of Dolby Digital
soundtracks, such as when watching a film late at night.

• Highlight DD compression in the Audio setup menu, and press Enter.

The following menu is displayed:

• Choose None for no Dolby Digital audio compression, Low boost to
increase the level of quiet passages, High cut to reduce the level of loud
passages, or Both for both low boost and high cut.
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Region codes

For commercial reasons many DVDs are encoded with one or more region
codes to identify the countries in which they can be used. Every DVD player
is assigned a region code to determine which discs it can play.

The different parts of the world are divided into regions 1 to 6 as shown in
the following diagram:

4 4

6

1

2

2

2

5

5

3

1 – USA, Canada 4 – Australia, Central & South America

2 – Europe, Near East, South Africa, Japan 5 – Africa, Asia, Eastern Europe

3 – South East Asia 6 – People’s Republic of China

If you try to play a disc which is assigned to the incorrect region code then
either a special screen or the following warning will be displayed:

If your 800 Reference DVD/CD Player is not set to your local region, please
contact your dealer.
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controls and Meridian System Remote.

This chapter explains how to configure the DVD/CD player without
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Alternatively, for complete control over all aspects of the DVD/CD

player’s configuration you can set up the unit from a computer using

the Meridian Configuration program. For full information refer to the

next chapter.
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The DVD/CD player provides several sets of standard settings, called Types,
which configure all aspects of the 800 into one of a number of alternative
standard configurations.

Types 0 to 5 are factory settings, designed to cater for the most commonly
needed configurations of associated equipment.

These standard Types are shown in the following table:

Type Main output Auxiliary output

Channels Bitstream 96kHz MHR Bitstream 96kHz MHR

0 6 Yes Yes Yes Yes Yes Yes

1 6 No Yes Yes Yes Yes Yes

2 2 Yes Yes Yes Yes Yes Yes

3 6 Yes Yes Yes No No No

4 6 No Yes Yes No No No

5 2 No Yes Yes No No No

Choose one of the Types 0, 1, or 2 if you want to connect the auxiliary
output to an alternative input on the main decoder, or to a second zone
with a suitable Meridian decoder.

Choose one of the Types 3, 4, or 5 if you want to connect the auxiliary
output to a non-Meridian decoder or preamplifier.

Choose one of the Types 0, 1, 3, or 4 if you are connecting the main output
to a multi-channel decoder input. Types 1 or 4 can also be used to connect
the main outputs to DSP loudspeakers.

Choose Type 2 to connect the main output to a 2-channel decoder such as a
non-DVD-Audio 861 or 568.

Choose Type 5 to connect the main output to a single pair of DSP
loudspeakers or a 2-channel preamplifier.

In addition, your installer may have provided one or more named User
Types, with settings appropriate to the configuration of equipment when
your 800 was installed.

You can reset the configuration of the DVD/CD player to any of these Types
to restore it to the state it was in when it was installed. Note: Selecting a
Type will clear any configuration and calibration changes you have made.
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Warning: this procedure will reset any configuration and
calibration changes you have made.

• Switch off any power amplifiers that are connected to the 800 and put
any digital speakers into standby.

• Put the DVD/CD player into standby by pressing Off (front panel or
remote).

• Press and hold down Gain+ (under the front panel).

The display shows: Type in... 3

• Keep holding down Gain+ for a further three seconds.

The display shows: Type- please wait.

Then after a short delay the display shows the current Type.

For example: Type   3

• Press A or V on the front panel to change the Type number.

The display shows: Typing, please wait.

• Wait for one second, and then put the DVD/CD player into standby by
pressing Off (front panel or remote).

• Switch on again to use the standard settings you have selected.

Setting up the DVD/CD player with other Meridian
equipment

If you are using the 800 with other Meridian equipment, such as the 861
Reference Digital Surround Controller, you should set up the comms with
the following automatic setup procedure:

• Switch all the units to standby.

• Press Clear (remote).

Each unit will display: Auto Setup

The 800 will then be designated as
the controller, and display: Controller
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All the other units will be configured
as non-controllers, and display: Not Controller

Your system is now set up and ready for use.

• If for any reason the automatic setup does not give the configuration
you want, restore the default operation by selecting one of the standard
Types; see Choosing a standard setting, page 50.

• If you are using the 800 with an 861, the 861 will be designated as
Controller and the 800 will be configured as Not Controller.

• If you are using the 800 with an 861 we recommend you set 800
present in the 861 configuration; see the Meridian 861 Reference
Digital Surround Controller User Guide.



53

CONFIGURING
WITHOUT A
COMPUTER Setting up sources

This section explains how to use Gain mode to set up the sources connected
to the DVD/CD player via an analogue input card.

To turn on Gain mode

• Put the DVD/CD player into standby by pressing Off (front panel or
remote).

• Press and hold the Gain- key under the front panel for at least five
seconds.

The display shows: Gain On

The DVD/CD player will then return to standby with Gain mode turned on.

Gain mode adds an extra Sensitivity option to the menus.

To turn off Gain mode

• Repeat the above procedure until
the display shows: Gain Off

To adjust the sensitivity of a source

To obtain the best signal-to-noise ratio for your analogue sources you can
adjust the sensitivity of each input to give the highest level that does not
produce clipping.

• Turn on Gain mode, as described above.

• Select the source you want to adjust, with loud source material playing.

• Press Function < or > (remote or under the front panel) until the display
shows the current sensitivity.

For example: Radio 2.0V In

• Press Function A or V (remote or under the front panel) to change the
sensitivity.

You can select between sensitivities of 0.5V (most sensitive), 1.0V, 2.0V, or
2.5V (least sensitive).
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The display shows, for example: Radio 0.5V In Clip

In this case reduce the sensitivity.

If you have selected a digital source you cannot adjust the sensitivity.

The display shows, for example: CD    Not Analogue
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The Meridian Configuration
program

The Meridian Configuration program is a stand-alone Windows-based
application that lets you design your own configuration of each 800 Series
product to suit your own personal preferences, and the particular
configuration of other equipment in your system.

The Meridian Configuration program provides the following sections to
allow you to control the corresponding aspects of each 800 Series product’s
operation:

Setup
Lets you specify general features of the product’s operation,
including the position of the on-screen display, the information
provided on the front-panel displays, the startup volume, and
settings affecting its operation in multi-room systems.

Outputs
Lets you configure the product’s outputs to suit other
equipment in your system.

Sources
Lets you customise the operation of each of the sources, the
digital or analogue inputs used for that source, and additional
information about the type of each source.

Cards
Displays information about each of the cards in the product,
and lets you add or remove cards.



57

CONFIGURING
USING A COMPUTER

Installing the Meridian
Configuration program

Requirements

To use the Meridian Configuration program you need:

• A computer running Windows 95, 98, 2000, ME, NT 4, or XP.

• A 100MHz or faster Pentium-class processor.

• At least 16Mbytes of RAM.

• 5Mbytes of free disk space.

• A vacant 9-pin serial port assigned to one of COM1 to 4.

The software requires a mouse or similar pointing device – it cannot be
operated solely from the keyboard.

To install the Meridian Configuration program

• Insert the first Meridian Product Configuration program installation disk.

• Choose Run... from the Start menu.

• Type A:  setup and press R.

• Follow the on-screen instructions, inserting the second installation disk
when prompted.

If you have an 861 Reference Digital Surround
Controller

If your equipment includes both an 800 Reference DVD/CD Player and an
861 Reference Digital Surround Controller configure the DVD/CD player
first.

Then configure the 861 as described in the corresponding chapter of the
861 Reference Digital Surround Controller User Guide.
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To run the Meridian Configuration program

• Click Start, point at Programs, then click Meridian Product
Configuration.

The Meridian window will be displayed:

The toolbar provides a convenient way of accessing the most important
menu options:

Button Option Function

New Creates a new settings file.

Open Opens an existing settings file.

Save Saves the current settings file to disk.

Fetch Fetches the current configuration of the attached
product(s).

Store Stores the current settings and User Types to
attached products.

Disconnect Disconnects the program from attached products.

Add product Allows you to add a product to the settings file.

Copy Copies text or settings onto the clipboard.

Paste Pastes text or settings from the clipboard.

Print Allows you to print a copy of your settings.

About Displays program information.
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To connect the serial cable

The serial cable is symmetrical, and can be connected either way round.

• Connect one end to the RS232 connector on the COMPUTER card (not
the DVD CONTROLLER card) on the back panel of the 800 Reference
DVD/CD Player.

• Connect the other end to one of the serial ports on the PC or PC
notebook computer.

Then specify the serial port you are using as follows:

• Choose Options from the View menu to display the Options dialogue
box:

• Select the port you want to use and click the OK button.
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Creating a new settings file

This section explains how to create a new settings file, using the Meridian
Configuration program, and how to enter personal information to identify
the settings in your product.

The first step is to fetch the initial settings from the 800 DVD/CD Player, to
use as a starting point for your configuration.

• Click the Fetch button in the toolbar:

The Progress dialogue box will show you the progress as the settings are
fetched:

A new settings file will be created for you, with the initial name MSF1, and
the Meridian window will show a CD/DVD machine icon to identify the
product you are configuring.

• Check that the correct product version number is displayed in the
Product version drop-down menu.

• Choose Save As from the File menu, enter an appropriate name for the
file and click the Save button.

To display the settings

• Double-click the CD/DVD machine icon, to open it and display the
settings it contains.
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The left-hand panel of the Meridian window will change to show the
following three icons:

Owner lets you enter personal information, for future reference, and
choose the message displayed when you first switch the unit on, and
Settings is the initial configuration in the settings file.

Double-clicking Return to top level takes you back to the previous level.

To enter your personal details

• Click the Owner icon in the left-hand panel.

• Enter any text you like in the Dealer, Owner, and Description fields.

You can enter up to 20 characters in each field, the size of the DVD/CD
player front-panel display:

The Owner text will be displayed when you turn the product on. The
Dealer and Description text are displayed after the product version and
serial numbers if you hold down the front-panel Display key in standby.
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The options on the Advanced tab are for use by a dealer in setting up a
multi-room system, and to upload a new version of the software to the
product, and it is recommended that you do not change these settings.

To display or edit the settings

• Double-click the Settings icon.

The Meridian window will change to show the four categories of settings
contained in the settings file: Setup, Outputs, Sources, and Cards.

The options available in each case are explained in the following sections.

At this stage you may find it useful to maximise the Meridian window so
you can see all the options on each screen.
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Setting up outputs

This section describes how to use the Meridian Configuration program to
configure the 800 Reference DVD/CD Player’s outputs to suit the other
equipment in your system.

For each audio format you can specify whether the equipment connected
to the Main and Tape digital outputs can decode that format.

The options are arranged in two columns:

• Main specifies the options for the main multi-channel outputs.
• Aux specifies the options for the auxiliary outputs.

DVD-Audio tracks may have between one and six channels active. When
playing a multi-channel recording, there may also be a 2-channel version
available on the 800 DVD/CD Player auxiliary output, depending on how
the disc was authored. If your playback system is 2-channel then the 800
should be configured to force a 2-channel output from the main left and
right outputs.

To specify the outputs

• Click Outputs in the left-hand panel of the Meridian window:

• In the Decoder section select 6-channel capable if your decoder can
accept a multi-channel input. This option is only available for the main
multi-channel outputs.
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• Select Decode bitstreams in player if you want the 800 DVD/CD
Player to decode bitstreams, such as Dolby Digital and DTS, to PCM on
the specified outputs.

Select the option if you are connecting the output to an external
surround decoder.

Leave the option unselected if you are connecting the output to an 861
via a Meridian multi-channel link, or to Meridian DSP loudspeakers or a
digital preamplifier.

• In the Maximum decoding rate section specify the maximum
decoding rate that the equipment connected to each set of outputs can
accept.

When playing audio at higher rates it will be downsampled to the rate you
have specified on the corresponding outputs.

To specify Meridian High Resolution (MHR)

Meridian High Resolution is a proprietary format using encryption and anti-
copy methods that allows secure transfer of audio streams between
elements of a Meridian-only system for the purpose of playback only. It
provides a secure copyright protection environment and has the very
important benefit of lowering jitter and improving sound quality on all
material.

The Meridian High Resolution options allow you to specify whether
MHR-encoding is used for each of the main digital outputs.

If you are connecting either of the outputs to non-Meridian equipment, or
Meridian equipment that is not MHR compliant, set the option for the
corresponding output to Never.

If you are connecting either of the outputs to a Meridian product that is
MHR compliant, such as the 861 Reference Digital Surround Controller, set
the option for the corresponding output to As needed to take advantage
of MHR.

Note: If you select Never, the 800 will downsample certain copy-protected
discs to 16-bit resolution at either 44.1kHz or 48kHz.
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Setting up sources

This section describes how to use the Meridian Configuration program to
configure the sources provided by the DVD/CD player.

To set up sources

• Click the Sources icon in the left-hand panel of the Meridian window.

The right-hand panel shows a list of the 12 sources that are available. For
each source you can display three pages of settings by clicking the
Options, Audio, or Advanced tabs.

To configure the source options

• Select the source in the list of sources.

• Click the Options tab:

• Select Source exists if you want to use this source.

You can prevent the source from appearing in the list of sources, or being
selectable using the Meridian System Remote, by disabling this option.

• If you want, you can change the name displayed when the source is
selected by editing the Name field.

The name can consist of up to five letters, digits, or the characters space,
full-stop, and minus. The name you specify is shown in the list of sources
followed by the Meridian System Remote key used to select the source in
brackets.
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• Click Select this source when product is switched on to specify that
this source should be selected when the DVD/CD player is switched on
from standby with a key other than a source key.

This would usually be chosen as either DVD or CD.

To specify the audio connections

• Click the Audio tab to show the connections for the audio inputs:

• Select the card in the Card list to specify the location of the connector
used for the source.

To use the internal DVD/CD drive select DV02, the DVD controller.

• From the Input on card drop-down menu specify the digital or
analogue audio input you want to use for the source, or Last valid to
leave the input unchanged when you select the source.

If you have chosen an analogue input for the main audio input:

• Specify the sensitivity of the input by choosing an appropriate option
from the Sensitivity drop-down menu.
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To set the advanced source options

• Click the Advanced tab to show the Advanced page of settings:

• If the source is a Meridian product (internal or external), set Comms
type to 1C for a CD player, 2C for an FM tuner, and 3C for a DVD
player. Otherwise set it to none.

• If you have more than one Meridian source of the same type you can
configure them to have different Comms addresses. You can then select
the appropriate source by specifying its Comms address in the Comms
address field. Normally this is set to 1.

• Select Source is internal to this product for the DVD controller.

• Select Poor digital audio source – frequency out of range if you
have difficulty locking to a source.

• Select any of Triggers 1, 2, or 3 to activate the specified trigger outputs
when this source is selected.
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Configuring cards

The Cards panel displays information about each of the cards in the
product, and lets you change the configuration of a card, and add or
remove cards.

You will normally only need to use this panel if you upgrade the 800
Reference DVD/CD Player by adding a new card.

To set up cards

• Click the Cards icon in the left-hand panel of the Meridian window.

The right-hand panel shows a list of the cards fitted to the product, and
allows you to add cards or remove cards:
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To change the address for a card

If you have fitted two cards of the same type you will need to assign a
different address to each card to identify them.

• Double-click the card in the Card column.

The Card properties dialogue box shows the card’s current setting:

• Select the address you want to use and click the OK button.
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Changing the setup options

The final stage in editing the settings is to configure the general Setup
options.

To change the setup options

• Click the Setup icon in the left-hand panel of the Meridian window.

The setup options are provided on three pages that you can display by
clicking the Setup, Video, or Advanced tabs.

To configure the setup options

• Click the Setup tab:

The Setup options are described in the following table:

Option What it means

Lock settings on product Locks the parameters.

Contrast and Brightness Set the default brightness and contrast for the front-panel
display.
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To configure the video options

• Click the Video tab:

These options are equivalent to the corresponding options on the
Playback options and Video setup menus; see Setting default options,
page 36.

To configure the advanced options

• Click the Advanced tab:
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The Advanced options are described in the following table:

Option What it means

Advanced OSD Replaces the repeat mode icon in the OSD with either the
bit rate (DVD-Video or DVD-Audio discs), or the number of
error corrections made (CDs).

Diagnostic displays Includes diagnostic displays in the display options.

Comms controller status Specifies whether the DVD/CD player is controller, not
controller, or set automatically.

System and Copy address For multi-room setups.

Fan Choose Never on, On out of Standby, On when source
is internal, or Always on to determine when the
internal fan is active.

Audio-only player Select this if the DVD/CD player is not connected to a
display to navigate DVD-Audio discs in the same way as
CDs.

Use multi-channel zone even Allows a 2-channel player to access multi-channel groups
in 2-channel player on DVD-Audio discs and produce a 2-channel downmix.

Output priority Choose priority to main output for the highest possible
audio quality on the main output, or aux output always
available to ensure there is always a version of the
content on the auxiliary output.

Dolby Digital compression Choose Compression off for no compression, Quiet
boost to increase the level of quiet sounds, Loud cut to
reduce the level of loud sounds, or Compression max for
both Quiet boost and Loud cut.



73

CONFIGURING
USING A COMPUTER

Creating a User Type

The final step is to store your settings permanently to the product as a User
Type, so that you can reset the unit to them whenever you need to.

When you store one or more User Types to the DVD/CD player they become
available in the list of Types, alongside the built-in Types. For more
information about selecting one of the Types see Choosing a standard
setting, page 50.

To name the User Type

• Click the Settings icon in the left-hand panel of the Meridian window:

• Enter a suitable name in the Type name field to identify your User
Type, such as Standard.

The name can have up to 12 characters.

To create additional User Types

If you wish you can create several User Types, and store them all to the
DVD/CD player. You can then reset the DVD/CD player to any of the User
Types by selecting the appropriate Type name.

To create a new User Type:

• Select the User Type you want to base it on in the left-hand panel of the
Meridian Setup window; eg Standard.

• Click the Copy as new user type button.

• Select In use if you want the User Type to be selected automatically
when you store it to the DVD/CD player.
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The User Type currently specified as In use is identified by the
circle icon in the left-hand panel of the Meridian window:

Initially the new type will be created with the same settings as the type you
based it on, and with the name New type:

You can then change the name of the new Type, and configure its settings,
in exactly the same way as for the original Type.

To copy settings between User Types

• Highlight the User Type you want to copy the settings from.

• Choose Copy from the Edit menu, or click
the Copy button in the toolbar:

• Highlight the User Type you want to copy the settings to.

• Choose Paste from the Edit menu, or click the
Paste button in the toolbar:

You can also copy and paste source and preset settings from one section of
a user type to the same section of another user type as follows:

• Highlight the icon corresponding to the section of settings you want to
copy: Sources or Cards.

• Choose Copy from the Edit menu, or click the
Copy button in the toolbar:
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• Highlight the same icon in the User Type you want to copy to.

• Choose Paste from the Edit menu, or click the
Paste button in the toolbar:
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Completing the configuration

The final stage in creating a settings file is to save it, and then store it to
the DVD/CD player.

To save the current settings

• Choose Save from the File menu or click the Save
toolbar button, to save the changes you have made
to the settings file to your PC hard disk:

To store the settings to the 800 Reference DVD/CD
Player

• Click the Store button:

The settings will then be downloaded
to the product, and the display shows:  Receiving Data...

As the download proceeds the following dialogue box shows its progress:

If the download was successful the product will briefly display the owner
name you have defined;

For example: Zachary Ford

It will then switch itself to standby.

The User Type you have created will now be available in addition to the
built-in Types, and will be selected by default if you need to reset the
configuration of the DVD/CD player; see Choosing a standard setting,
page 50.
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DVD
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OffMeridian 800
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AC-3

An alternative name for the Dolby Digital format.

Controller

The product in a Meridian system that uses the infra-red signals from the
remote to control the system. The controller is normally chosen
automatically, but the installer can override this.

CPPM

Content Protection for Prerecorded Media, a cryptographic method for
protecting entertainment content when recorded on physical media.

CSS

Content Scrambling System, a method for protecting the copyright in
recorded works.

Dolby Digital

A digital surround-sound which provides five full-frequency range channels
(left, centre, right, left surround, and right surround) and an additional
Low Frequency Effects (LFE) channel which is band limited to 120Hz.

Dolby Surround

The encoding system used for the majority of movies on video and many TV
broadcasts. Dolby Surround encoded material can be replayed with a
surround decoder connected to an array of loudspeakers which normally
include at least left, centre, right, and rear surround.

DTS

Digital Theatre Systems originally produced digital audio tracks for motion
pictures. A version of this format adapted for consumer video and audio
products is referred to as DTS Entertainment. Like Dolby Digital it provides
five full-frequency range channels (left, centre, right, left surround, and
right surround) and an additional Low Frequency Effects (LFE) channel.

DVD

Digital Video Disc or Digital Versatile Disc, a CD-sized disc with nearly 30
times the storage capacity of CD. It is capable of storing digital video, high-
quality multi-channel audio, or computer data.
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DVD-Audio

A DVD containing audio tracks in one or more of a number of alternative
formats to provide higher quality or higher capacity than CD, multi-
channel audio, together with the option of still images or video. A DVD-
Audio disc may also include lower quality versions of the material in DVD-
Video format for compatibility with players that do not support DVD-
Audio.

DVD-Video

A DVD containing video tracks together with one or more soundtracks,
menus, and other entertainment features.

Menus

The flexible system for choosing options and configuring settings in
Meridian products. On the 800 the menus are controlled by the <, >, A,
and V keys on the front panel or the MSR.

MHR

Meridian High Resolution is a proprietary secure encoding format using
encryption and anti-copy methods that allows secure transfer of audio
streams between elements of a Meridian-only system for the purpose of
playback only. It provides a secure copyright protection environment and
has the very important benefit of lowering jitter and improving sound
quality on all material.

MLP

MLP (Meridian Lossless Packing) is an audio format that increases the
amount of information that can be recorded on a CD or DVD, without any
loss of quality. MLP is a mandatory format for DVD-Audio.

MPEG Audio

MPEG Audio is a digital encoding system developed by the Motion Picture
Expert Group. Like Dolby Digital it provides five full-frequency range
channels and an additional Low Frequency Effects (LFE) channel.

MPEG Video

MPEG Video is a video compression technique used to encode video for
DVD-Video discs.

MSF

Meridian Settings File, a file containing settings and User Types for one or
more Meridian Products.
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MSR

The Meridian System Remote, or handset.

OSD

On-screen display, which the 800 can superimpose on the video image to
give information about the disc.

PCM

Pulse Code Modulation, the method used to encode music digitally, as used
on audios CDs.

Source

An input to the system, such as CD or TV. The Meridian 500 and 800 Series
provide 12 named sources, corresponding to the names of the 12 source
keys on the MSR. In the 800 you can choose the label displayed for each
source, and the input used for it.

Type

A standard configuration of the DVD/CD player. Selecting a Type resets any
configuration changes.
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A

A-B (remote) 24
audio CDs 16
on-screen display 20
audio connections, setting up using
a PC 66
Audio language menu 38
audio soundtracks, selecting 25
Auto Setup 51

B

balance, changing 34
Black level menu 41
brightness, front-panel display 19

C

camera angle, changing 27
Cards icon 56
cards, setting up using a PC 68
chapters 16
moving to next/previous 16
playing from 16
selecting by number 16
clip indicator 54
Closed captions menu 42
comms, setting up 51
configuring
with a computer 55
without a computer 49
continuing after pausing 18
contrast, front-panel display 19
controller, setting up 51
copying settings between user
types 74

D

Decode bitstreams in player
option 45, 64
default languages, selecting 38
disc menu 22
display
front panel 19
on-screen 20

Display aspect ratio menu 40
display settings 40
Dolby Digital compression,
specifying 47
DVD-Video discs 16
camera angle 27
DVD-Audio discs 14
groups 14
images 14, 15
playing 14

F

front panel keys 10

G

Gain mode 53
glossary 77

I

Information menu 36
inserting a disc 13
installing the Meridian
Configuration program 57

L

language
screen displays 39
subtitles 39

M

maximum sampling rate option 46
Menu key 22
Menu language menu 39
Meridian Configuration program 56
installation 57
requirements 57
running 58
toolbar buttons 58
Meridian High Resolution (MHR) 4, 64
specifying 46
Meridian System Remote keys 11
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MP3 discs 13
creating 3
moving between albums 13
multi-channel link 2, 45
multi-channel outputs 47
multi-channel, switching from
stereo 25
muting the sound 33

O

on-screen display 20
changing 19
disc information 20
Open (front panel) 13
Options (View menu) 59
Options dialogue box 59
Outputs icon 56
outputs, setting up using a PC 63
Owner icon 61

P

parental lock, setting 28
pausing play 18
PC, using to configure the 800 55
personal details, entering using a
PC 61
phase, changing 34
Playback options menu 28, 36, 38
playing 13
a specific title 17
faster than normal 23
from a particular chapter or track 16
from a specified timecode 17
in slow motion 23
repeatedly 24
preamplifier features 31

R

region code violation error 48
region codes 48
repeating
a specific section of a disc 24
a title, chapter, or track 24
return to top level icon 61

S

Save As (File menu) 60
screensaver options 43
selecting a source 32
serial cable, connecting 59
serial port, specifying 59
settings file, creating 60
Settings icon 61, 62
Setup icon 56, 70
Setup menu 28, 36
sound, muting 33
soundtrack languages 38
selecting default 38
soundtracks, selecting 25
sources 32
adjusting sensitivity 53
configuring options using a PC 65
selecting 32
setting advanced options using a PC 67
setting up using a PC 65
specifying audio connections using a PC 66
Sources icon 56, 65
specification 6
standard settings, selecting 51
standby, switching to 12
stepping forward frame by frame 18
stopping play 18
Subtitle language menu 39
subtitles 26
closed caption 42
displaying current settings 26
selecting languages 26
setting the default language 39
turning on or off 26
switching on and off 12

T

technical overview 4
timecode, playing from 17
titles 16
locating 16
locating by number 17
selecting from the title menu 22
Toolbar buttons 58
Top Menu 15, 22
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tracks 16
locating by number 16
moving to next/previous 16
TV standard, selecting 42
Types 50

U

User Types
copying settings between 74
creating 73
naming 73

V

Video setup menu 36, 40
volume, adjusting 33
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